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Chapter 3

. ILWIS window types
and their functionality

3.1 Main window

3.1.1 Introduction
The picture below contains hotspots with additional information:

The Main window contains:
n Menu bar: the Main window has five menus: File, Edit, Operations, Options, and

Help.
n Command line: the command line is found just below the menu bar. Advanced

users can type commands and expressions on the command line to perform map
calculations, operations, and series of calculations and/or operations described in
user-written scripts.

n Button bar: located just below the command line. The button bar provides short
cuts for some regularly used menu commands.
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n The navigator is found to the right of the button bar. Use the navigator to select
another drive or subdirectory.

n Catalog: the central part of the Main window is called the Catalog. It provides an
overview of available ILWIS objects in the current directory.

n Data objects in the Catalog can be double-clicked, and can be dragged to an
existing map window, to the pixel information window, to an operation in the
Operation-list, or to a text or list box in a dialog box. By using the right mouse
button on a data object in the Catalog a context-sensitive menu appears which
contains all relevant operations for that object.

n Service objects and special objects can be double-clicked to display or edit them.
n The horizontal scroll bar below the Catalog allows you to view more objects of

the current directory in the Catalog.
n Operation-list: located along the left side of the Main window. The Operation-

list provides an overview of ILWIS operations. Operations are preceded by an
icon of the output object of that operation. You can start an operation by double-
clicking an operation in the Operation-list, or by dragging an ILWIS object from
the Catalog to the operation in the Operation-list to start the operation with that
object. Of course, you can also start operations by selecting one from the
Operations menu.

n The vertical scroll bar to the right of the Operation-list allows you to view more
operations in the Operation-list.

n Status line: located at the bottom of the Main window. The status line gives short
explanations on highlighted menu commands, functionality of buttons in the
button bar, the description of objects in the Catalog, and a short description of
the operations in the Operation-list.

The Main window can be sized by dragging its borders. For information on
minimizing, maximizing the Main window, using scroll bars, using menus, etc., see
the Introduction on Windows features topic.

3.1.2 Catalog
The Catalog is located at the central part of the Main window. The Catalog provides
an overview of ILWIS objects in the current directory.

By default, the Catalog lists available data objects in the current directory; these are
preceded by the following icons:

for map lists
for raster maps
for polygon maps
for segment maps
for point maps
for map views
for tables
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If you want to see more or other objects in the Catalog, refer to How to customize
the Catalog. For short help on objects in the Catalog, click an object with the right
mouse button and choose Help from the context-sensitive menu.
The Catalog is sensitive to clicking, double-clicking and drag and drop actions. You
can for instance use the Catalog to display a map or table or to start an operation
with a certain map or table. Using the Catalog capabilities is far more efficient than
using menus. For more information, see How to use the Catalog.
In general, it can be mentioned that:
n when moving the mouse pointer over an object in the Catalog, the status line

displays the description of that
n double-clicking an object in the Catalog opens that object in a new window,
n clicking the right mouse button on an object in the Catalog makes a context-

sensitive menu appear from which you can choose a command or an operation,
n dragging a raster, polygon, segment or point map to an existing map window or

to the pixel info window, adds that object to that window,
n dragging a data object from the Catalog to an operation in the Operation-list,

opens the dialog box for that operation with the input map (or table) name
already selected,

n when a dialog box is opened and it contains a drop-down list box, you can drag
an object from the Catalog to this list box instead of selecting the desired object
from the list box.

For more information, refer to section 8.36.1 How to use the Catalog and section
8.11.1 How to customize the Catalog

3.1.3 Operation-list
The Operation-list is located along the left side of the Main Window. The
Operation-list provides an overview of ILWIS operations. Each operation is
preceded by an icon; the icon indicates the output data type of the operation.
Furthermore, the Operation-list contains New commands to create new objects,
Show and Edit commands, to show/open or edit an object and Pixel Info command
to open the pixel information window.

For more information on available operations in the Operation-list, see the help on
ILWIS Operations. For short Help on operations in the Operation-list, click an
operation with the right mouse button and choose Help from the context-sensitive
menu.

Just like the Catalog, the Operation-list is very sensitive to clicking, double-clicking
and drag and drop actions. The Operation-list is mostly used to start operations
bypassing the Operation menu, or to create, show or edit objects. Using the
Operation-list capabilities is far more efficient than using menus. For more
information, see Help topic How to use the Operation-list.

In general, it can be mentioned that:
n when moving with the mouse pointer over an operation, the status line displays a

brief description of that operation,
n double-clicking an operation starts that operation,
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n dragging a data object from the Catalog to an operation in the Operation-list,
opens the dialog box for that operation and the input map (or table) name is
already selected,

n when clicking an operation with the right mouse button, a little context-sensitive
menu appears; you can start the operation or obtain short Help on this operation.

For more information, refer to section 8.36.6 How to use the Operation-list or to
chapter 7 ILWIS operations.

3.1.4 Main window Command line
The command line of the Main window is located at the top of the Main window,
just below the menu bar. A picture of the Main window is presented in Help topic
Main window: introduction.

The user may type commands and expressions on the command line to carry out
calculations, operations and scripts.

The command line is used:
n to perform calculations with maps and attribute tables,
n to perform ILWIS commands: to display, edit, create or view the properties of

ILWIS objects, and to obtain dialog boxes to start an ILWIS operation. This
functionality is equivalent to typing an ILWIS 1.4 executable name on the DOS
command line in ILWIS version 1.4.

n to perform ILWIS expressions: to perform complete ILWIS operations. This
functionality is equivalent to typing the ILWIS 1.4 executable name and all
parameters required by this executable, on the DOS command line in ILWIS
version 1.4.

n to run scripts, which usually contain a sequence of ILWIS expressions. With a
script, you can build a complete GIS and Remote Sensing analysis/application
for your own research discipline. Scripts are more or less equivalent to batch
files in ILWIS version 1.4.

n to copy and delete objects, break dependency links of objects, etc. For more
information, see ILWIS commands and ILWIS script syntax.

F The command line has a history: use the Arrow-Up key to retrieve previously used
expressions and commands. The Arrow-Down key can be used to scroll forwards
again.

Other functionality:
?expression Performs calculations as a pocket line calculator,
!Applic Acts as the Windows Run command to start any Windows 

application program, batch file, or DOS application (with a .
PIF file available). Applications that can be started from the 
command line may have the following extensions: .exe, .com, 
.bat, .pif. Type the application name directly after the 
exclamation mark (no spaces allowed). Example: to start 
Word, type: !Winword.

Miscellaneous Copy, del, cd, md, rd. For more information, see Appendices : 
ILWIS commands.
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The command line can be hidden or shown by opening the Options menu in the
Main window, choose Command line.

For more information, refer to chapter 6 MapCalculation or to the Appendices :
ILWIS commands and Appendices : ILWIS expressions

Pocket line calculator
The command line in the Main window and the command line of a table window
can be used as a pocket calculator.

Type a question mark on the command line followed by an expression, i.e. a
combination of constant values and operators or functions. It is allowed to use map,
table and column names in the pocket line calculator.

Examples:
? 2 + 4 returns 6
? SQRT(64) returns 8
? POW(2,8) returns 256
? MyFunc(22,44,66) returns the result of a user-defined function 'myfunc'; the

first three parameters in this function are replaced by values
22, 44, and 66.

Constant value π can be used by typing PI, constant value e can be used by typing
EXP(1).

For more information, refer to sections MapCalc, Pocket line calculator or TabCalc
in Chapter 6.

3.1.5 Main window Button bar
The button bar is located between the command line of the Main window and the
Catalog in the Main window. Buttons in the button bar provide short cuts for some
regularly used menu commands. Buttons can be clicked to invoke a certain action.
When the mouse pointer is located above a button, the status line provides a short
explanation of the effect of the button.

The picture below contains hotspots with additional information:

The following actions can be performed:

Show Operation-list button: Hides or shows the Operation-list along the left side of
the Main window.

Show Map button: Opens a raster, segment or polygon map in a new map window or
opens any other ILWIS object. Select a map in the showing dialog box, enter display
options for the map.
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Show Table button: Opens a table in a new table window. Select a table in the
appearing dialog box.

Open Pixel Information window button: Opens the Pixel Information window.

Customize Catalog button: Opens the Customize Catalog dialog box which allows
you to select the object types that are visible in the Catalog.

The button bar can be hidden or shown with menu command Options, Button Bar.

3.1.6 Navigator
The navigator is located to the right of the button bar in the Main window. The
navigator allows you to select another directory or another drive. A picture of the
Main window is presented in Help topic Main window: introduction.

Click one of the list boxes or one of the little buttons with the arrow, and select a
new drive or a new directory. It is advised to access data from the hard disk, not
from floppy drives.

3.1.7 Main window Status line
A status line is located at the bottom of the Main window.

The status line:
n gives a brief explanation on highlighted menu commands,
n gives a brief explanation on the effect of buttons in the button bar when moving

with the mouse pointer over a button,
n displays the description of objects when moving with the mouse pointer over an

object in the Catalog,
n displays the description of operations when moving with the mouse pointer over

an operation in the Operation-list.

3.1.8 Main window Menu commands
File Create Create Point Map ...

Create Segment Map ...
Create Raster Map ...
Create Map List ...
Create Table ...
Create Two dimensional Table
Create Domain ...
Create Representation ...
Create Georeference ...
Create Coordinate System ...
Create Sample Set ...
Create Filter ...
Create Function ...
Create Script ...

Open ...
Open Pixel Information
Switch to select window
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Close All
Minimize All
Restore All
Import ...
Export ...
Batch Import from 1.4 ...
Exit

Edit Edit Object ...
Properties
Copy Object ...
Delete Object ...

Operations Visualization Show Map ...
Show Table ...
Color Composite ...
Display 3D ...
Apply 3D ...
Slide Show ...

Raster Operations Map Calculate ...
Attribute Map ...
Cross ...
Aggregate Map ...
Distance ...
Iteration ...
Area Numbering ...
Sub Map ...
Glue Maps ...
Mirror Rotate ...

Image Processing Filter ...
Stretch ...
Slicing ...
Color Separation ...
Cluster ...
Sample ...
Classify ...
Resample ...

Statistics Histogram ...
Raster Autocorrelation ...
Map List Principle Components ...

Factor Analysis ...
Variance-Covariance ...
Correlation Matrix ...

Polygons Neighbour Polygons ...
Segments Direction Histogram ...
Points Spatial Correlation ...

Pattern Analysis ...

Interpolation Densify Map ...
Contour Interpolation ...
Point Interpolation Nearest Point ...

Moving Average ...
Moving Surface ...
Trend Surface ...
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Vector Operations Unique ID
Polygons Attribute Map ...

Mask Polygons ...
Assign Labels ...
Transform Polygons ...

Segments Attribute Map ...
Mask Segments ...
Assign Labels ...
Sub Map ...
Glue Maps ...
Densify Coordinates ...
Transform Segments ...
Tunneling ...

Points Attribute Map ...
Mask Points ...
Sub Map ...
Glue Maps ...
Transform Points ...
Transform Coordinates

Rasterize Polygon to Raster ...
Segment to Raster ...
Segment Density ...
Point to Raster ...
Point Density ...

Vectorize Raster to Polygon ...
Raster to Segment ...
Raster to Point ...
Polygon to Segment ...
Polygon to Point ...
Segment to Polygon ...
Segment to Point ...

Table Operations Transpose Table ...

Options Catalog ...
√ Active
Digitizer Map Reference

Digitizer Set-up
√ Command Line
√ Operation-List
√ Button Bar
√ Status Line

Help Help on this Window
Contents
Search
Index
Glossary
Operations
Menu Commands
How to ...
How to use Help
About ILWIS
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3.1.9 Main window Mouse functions
Both the Catalog and the Operation-list are very sensitive to clicking, double-
clicking and drag and drop actions. Using the Catalog and Operation-list capabilities
is far more efficient than using menus.

Moving with the mouse over
n A command on a menu: the status line displays information that helps explain

the task of the highlighted menu command; Highlight a menu command by
opening a menu and drag the mouse pointer along the commands on the menu.
You can also use the Up Arrow and Down Arrow keys on the keyboard to move
through the commands on a menu;

n A button in the button bar: the status line gives a short explanation of the
function of the button;

n An object in the Catalog: the status line displays the description of the object;
n An operation in the Operation-list: the status line gives a brief explanation on the

operation.

Clicking
n A button in the button bar: performs the action of the button.

Double-clicking
n A map, table and most other objects in the Catalog: the object is opened in a new

window;
n A filter in the Catalog: starts the Filter operation, the Filter dialog box is

displayed;
n A script in the Catalog: starts to run the script;
n An operation in the Operation-list: the operation's dialog box appears;
n Another directory or drive in the Catalog, changes the current directory or drive;

Drag
n A raster, polygon, segment, or point map from the Catalog to an existing map

window: adds the map as an extra data layer to the map window. It is not
possible to display two raster maps in one map window;

n A raster, polygon, segment, or point map from the Catalog to an existing pixel
information window: adds the map to the pixel info window. When an attribute
table is linked to the map, the attribute values also appear;

n A data object from the Catalog to an operation in the Operation-list: the dialog
box of that operation appears with the data object specified as input for the
operation;

n An object from the Catalog to a drop-down list box in an opened dialog box of
an operation: the object is put in the box.

Clicking the right mouse button
n On an object in the Catalog: a context-sensitive menu appears from which you

can select an operation that you want to perform with this object, or a command
such as Open, Edit, Properties, Copy and Delete. You can also select Help from
the context-sensitive menu to obtain short Help on the selected object type;
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n On an operation in the Operation-list: a context-sensitive menu appears from
which you can select Run to start the operation, or select Help to obtain short
Help on the selected operation.

For more information, refer to section 8.36.1 How to use the Catalog.

3.2 Map window

3.2.1 Introduction
In a map window, you can display a raster map, one or more vector maps, or one
raster map together with one or more point, segment, or polygon maps and
annotation. The different maps in a map window are called data layers. Grid lines,
legend, text and symbols are called annotation layers. You can open as many map
windows as you like. Maps can be edited with the editors.

Map windows have a menu bar, a  button bar and a status line.

For information on minimizing, maximizing a map window, using scroll bars etc.,
see section 1.2.1 Introduction on Windows features.

3.2.2 Functionality
A map window can display multiple maps and annotation, for instance:
n a raster map with one or more point maps, segment maps, polygon maps, and

annotation, or
n a segment map with one or more point maps, other segment maps, polygon

maps, and annotation, etc.
When multiple maps are displayed in the same map window, the different maps are
called data layers. You can also have annotation layers.

It is not possible to display two or more raster maps in the same map window. You
can open as many map windows on the screen as you like.

A map window contains a menu bar, a button bar and a status line. Besides
displaying, you can also edit maps in a map window.

To open a new map window
A map window can be opened, by opening the File menu in the Main window, and
choosing the Open command, by double-clicking a map in the Catalog, or by
choosing the Open Map Window command from the File menu in an existing map
window. You can also use the open button in the button bar of the Main window, or
the Show command in the Operation-list. Before a map is actually displayed, some
display options have to be specified. In the Catalog, maps are preceded by the
following icons:

raster maps,
polygon maps,
segment maps,
point maps.
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To display one or more data and annotation layers in the same map window
You can add data and annotation layers to a map window by opening the Layers
menu, and choosing the Add Data Layer or the Add Annotation command. As
annotation, you can add: text, legend, scale bar, North arrow, grid lines, graticule,
boxes, etc. You can also drag a point, segment, polygon, or raster map from the
Catalog to the map window. Display options have to be specified. In the display
options dialog box of maps with an attribute table, you can choose to display a map
by one of its attributes. When a second raster map is added to a map window which
already contains a raster map, the second raster map replaces the first.

To get info on data layers and attributes
Pressing the left mouse button at a position of interest in the map window, shows
information on a data layer. When, for example, a satellite image is displayed in the
map window, you will see the pixel value at the current mouse position. When a
rasterized polygon map is displayed that contains for example land use classes, you
will see the names of the land use classes. When pointing to a segment, or point in a
map window, the code of the segment or the name of the point is displayed. To see
information on a data layer it is necessary that the 'Info' check box is marked in the
Display Options dialog box of the layer. You can also turn 'Info' on by opening the
Layers menu and choosing Layer Management.

When a map window displays multiple data layers and you click somewhere in the
map window to get info, a search is performed at the position of the mouse pointer
through all layers (from top to bottom) that are displayed in the map window, and of
which the Info check box is selected. When in the first layer a class name, identifier,
value or a color is found, it is displayed next to the mouse pointer. When an
undefined value is found, the search continues in the next layer. If in a raster map no
class name, identifier, value or color is found, a question mark is shown. If in a
vector map no class name, identifier, or value is found, nothing is shown. When a
map is shown by one of its attribute values, Info shows the class name or identifier
and the attribute value of this class name or identifier.

When an attribute table is linked to a map or its domain (class or ID domain), you
can double-click at a position of interest to retrieve the attributes from the attribute
table. The action performed while double-clicking is determined by the Double-
Click Action command on the Layers menu. See also Map window : functionality
(advanced).

F Window and in the map editors by setting the 'width' in the properties of the domain.
The default width for a class domain is 15, the default width for an identifier domain
is 6.

F To inspect all meanings and/or values of multiple maps and attribute data, you can
open the pixel information window.

To zoom in on maps
There are several ways to zoom in on maps: you can select the Zoom In command
on the Options menu, or you can click  the Zoom In button in the button bar. You
can also press the Ctrl+I keys on the keyboard, or choose the Select Area command
on
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the context-sensitive menu which appears when clicking the right mouse button in
the map. If you zoom in very deeply on a raster map, the values or meanings of
pixels appear inside the pixels of your map. There are similar ways to zoom out and
to display the entire map again: use the Zoom Out or Entire Map commands on the
Options menu, use the Zoom Out button or Entire Map button in the button bar, or
press the Ctrl+O keys on the keyboard.

Zoom In: When you choose Zoom In from the menu or from the button bar: the 
mouse pointer changes into a magnifying-glass. Click somewhere in the 
map to zoom in on this spot, or drag the mouse pointer from one corner 
of interest to another (the pointer changes into a little box).

Ctrl+I: Zooms in with factor 2 on center of map.
Zoom Out: Zooms out directly from the center of the displayed map with a factor 2.

Scrolling through a map window
When you zoom in on a map, scroll bars will appear at the right and bottom side of
the map window. You can use the scroll bars in the normal way with the mouse (see
Help topic Windows features : introduction), but you can also use the following key
combinations:
n PageUp, PageDown, Home, or End to scroll up, down, to the left or to the right,

or
n Ctrl+PageUp, Ctrl+PageDown, Ctrl+Home and Ctrl+End to scroll vertically to

the top line, bottom line, and to scroll horizontally to the first column and  last
column.

To move the mouse pointer exactly one screen pixel up, down, to the left, or to the
right, you can use the Arrow keys on the keyboard.

To change representation
If you are not satisfied with the current colors of the map in your map window:
n you can create a new representation for domain Class maps, domain Value maps,

and Images in the Display Options dialog box of the map, or
n when the map window displays a map which uses a user-defined representation,

you can also open Edit menu and choose Representation.

The representation of a map depends on the domain of a map. For more information
see Help topic How to use Representations. For domain Class maps, you can also set
the double-click action to Edit Representation (Layers menu); double-clicking in the
window then allows you to edit colors directly.

To edit maps
To edit maps you can start one of the editors. In raster, polygon, segment and point
maps, the IDs, class names or values in these maps can be edited, depending on the
domain of the map. In polygon maps, the position of coordinates within polygon
boundaries can be edited and in segment maps the position of coordinates within
segments. Furthermore, new polygons, segments or points can be inserted with or
without using the digitizer. Dependent maps cannot be edited, first break the
dependency links.
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To view or edit attributes
When a map is of the domain type Class or ID, and an attribute table is linked to the
map (see the properties of the map, or the properties of the domain), attributes can
directly be viewed and edited by double-clicking in the map. Note that the action
performed by double-clicking is determined by the Double-click action command on
the Layers menu.

Other functionality
n The background color of maps displayed in a map window can be changed by

selecting Background Color from the Layers menu.
n The size of a map window can be increased or decreased by selecting the Extend

Window command from the Options menu. This is useful if you want to add
annotation.

n The distance and angle between two points in a map window can be measured by
selecting the Measure Distance command from the Options menu or by clicking
the Measure Distance button in the button bar.

n The coordinate system or georeference used by a map window can be changed
by selecting Coordinate System from the Options menu. This is useful to display
map(s) with different coordinate systems.

To save multiple layers as a view
When you have displayed more than one data or annotation layer in a map window,
you can save the contents of this window as a map view. When a map view is
opened later, all the layers in the map view are directly displayed in one map
window without any display options being asked.

To print a map window
See also How to print a map and annotation.

To close a map window
In Windows 3.1, close a map window by double-clicking the Control-menu box in
the upper-left corner of the map window. Or select the Close command on the
Control menu which appears by clicking the Control-menu box.

Double-click actions
For maps (raster, polygon, segment and point) of the domain Class type, three
double-click actions can be defined. For maps of the domain ID type, two double-
click actions can be defined. The third double-click action especially, may give
spectacular effects.

1. Change the color of a mapping unit when a mapping unit in a domain Class 
map is double-clicked.

2. View and/or edit attributes of a mapping unit when a mapping unit in a domain 
Class map or an element in a domain ID map is double-clicked. Attributes 
should be stored in an attribute table that is linked to the map
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3. Show another map, a GIF image, a bitmap, play a sound or a video, etc. when a
mapping unit in a domain Class map or an element in a domain ID map is 
double-clicked. In an attribute table linked to the map, a column Action using 
the String domain should be defined. In this Action column, you specify a file 
name of a map or table and its extension (.MPR, .MPA, .MPS, .MPP, .TBT), or
a GIF image, picture, sound or video that you want to see/hear while double-
clicking a mapping unit in a domain Class map or an element in a domain ID 
map.
Windows' File Manager should be used to associate non-ILWIS files with a 
program that can open these files. Native ILWIS extensions are already 
associated with ILWIS during the Set-up of ILWIS. Associations can be found 
in the WIN.INI file.

The double-click action first searches for a value that is not undefined through all
layers (from top to bottom) that are displayed in the map window, and of which the
Info check box is selected. You can see which value is found when you press the left
mouse button in the map window (Info). The Info check box can be selected in the
Display Options dialog box of each map or in the Layer Management dialog box.

1.  To edit the representation by double-clicking
n From the Layers menu, choose Double-click action, and
n select Edit Representation in the dialog box.
When you double-click in the map window and a class name is found, then a Color
dialog box appears in which you can select another color for this class.

Redraw  the map to apply the changes. If another non-undefined value is found,
nothing happens.

2.  To edit attributes by double-clicking
n From the Layers menu, choose Double-click action, and
n select Edit Attributes in the dialog box.

When you double-click in the map window and a class name or an identifier is
found, and an attribute table is available, then the attributes of this class or identifier
are shown in a separate window. You can also edit the attributes there. If no attribute
table is found, or if another non-undefined value is found, nothing happens.

3.  To perform an action by double-clicking
n From the Layers menu, choose Double-click action, and
n select Execute Action in the dialog box.

Make sure that:
- an attribute table is linked to the map,
- this attribute table has a column Action (column of domain String type)
- you have typed in this column file names inclusive path and extension of the 
  map, table, GIF image, picture, sound or video that should be opened when 
  you double-click a certain mapping unit or element,
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- you used the Windows 3.1 File Manager (File menu, Associate) to associate 
  non-ILWIS extensions with a program that can open files with these 
  extensions. In Windows '95, this can be achieved using the Open With 
  command on the File menu.

When you double-click in the map window and a class name or identifier is found,
and the double-click action is set to Execute Action, and an attribute table is found
with a column Action in which a filename is found that has a known association,
then that file is opened (map or table is shown, audio or video is played, etc.). If
another non-undefined value is found, nothing happens.

Display a map list as a slide show
A map window can show multiple raster maps like a slide show.  All maps that you
want to show need to be combined in a map list, then the maps in the map list are
displayed one by one in a map window at a user-specified rate. Create a map list of
the maps that you want to show. Then, open the map list for instance by selecting
Open from the context-sensitive menu when clicking the map list in the Catalog, or
by double-clicking the Slide Show item in the Operation-list, or by using the
Operations menu in the Main window.
In a slide show, only one set of Display Options will be used; the defaults are based
on the first map in the map list. The parameters set for this map define the display
options for the other maps in the map list. Specify the number of images you want to
see in the map window in the Display Options - Map List dialog box.
For more information, see How to display a map list as a slide show.

3.2.3 Map window Button bar
The button bar is located just below the menu bar of a map window. Buttons in the
button bar perform short cuts for some regularly used menu commands. Buttons can
be clicked to invoke a certain action. When the mouse pointer is located on a button,
the status line provides a short explanation of the effect of the button.

The picture below contains hotspots with additional information:

The following actions can be performed:

Entire map: Displays the entire map in the map window.

Zoom In: Zooms in with a factor of 2 on a selected spot or area in the map. The
mouse pointer changes into a magnifying-glass. Click somewhere in the map to
zoom in on this spot, or drag the mouse pointer from one corner of interest to
another (the pointer changes into a little box).

Zoom Out: Zooms out directly from the center of the displayed map with a factor 2.

Larger: Enlarges the size of the window with a factor 2. If the enlarged window
would not fit on your screen, this button is empty.
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Smaller: Reduces the size of the window with a factor 2.

Redraw: Redraws the contents of the map window. Press Esc to stop redrawing.

Measure Distance: Allows you to measure the distance and the angle between two
points in the map window.

The button bar can be hidden or shown with the Button Bar command on the
Options menu. If an action of a certain button cannot be performed at a certain
moment, the button appears gray.

3.2.4 Map window Status line
A status line is located at the bottom of each map window.

The status line:
n gives a brief explanation on highlighted menu commands,
n gives a brief explanation on the functionality of buttons in the button bar,
n displays the X and Y coordinate information depending on the position of the

mouse pointer in the map window,
n displays Row and Column numbers when a raster map is displayed, and
n displays geographic coordinates when the coordinate system used by a point,

segment or polygon map, or by a georeference of a raster map, has projection
information.

For more information, see Help topic How to use the status line

3.2.5 Map window Menu commands
File Create Create Point Map ...

Create Segment Map ...
Create Raster Map ...
Create Sample Set ...
Create Georeference ...

Save View
Save View As ...
Save Raster Map As ...
Open Map Window ...
Open Pixel information
Print ...
Printer Set-up
Exit

Edit Copy
Paste
Edit Layer select layer
Edit Other Map Pixel Editor ...

Point Editor ...
Segment Editor ...
Polygon Editor ...

Annotation
Properties select layer
Representation select layer
Domain select layer
Georeference
Coordinate System
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Layers Add Data Layer Raster Map ...
Segment Map ...
Polygon Map ...
Point Map ...

Add Annotation Text ...
Legend ...
Grid Lines ...
Graticule ...
Box ...
Scale Bar ...
North Arrow ...
Bitmap or Picture ...

Display Options select layer
Layer Management
Background Color ...
Double-Click Action ...

Options Entire Map
Zoom In
Zoom Out
No Zoom
Redraw
Measure Distance
Larger
Smaller
Extend Window Extend by Percentage ...

Extend by Coordinates ...
Coordinate System ...
√ Adjust Window Size
√ Button Bar
√ Status Line

Help see Main window

Context-sensitive menu
Select Area
Layer Management ...
Double-Click Action ...
layers

3.2.6 Map window Mouse functions

Moving with the mouse over
n A map in a map window: the status line displays XY-coordinates when a raster

map in the map window has a georeference other than georeference None, and
when vector maps in the map window have a coordinate system other than
coordinate system Unknown; When the map window contains a raster map, also
row and column numbers of the raster map are displayed. When the maps in the
map window have a coordinate system with projection information, the status
line also shows the coordinates in LatLon-coordinates;
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n A command on a menu: the status line displays information that helps explain
the task of the highlighted menu command. Highlight a menu command by
opening a menu and drag the mouse pointer along the commands on the menu.
You can also use the Up Arrow and Down Arrow keys on the keyboard to move
through the commands on a menu;

n A button in the button bar: the status line gives a short explanation of the
function of the button.

Clicking
n A map in a map window: the class names, IDs or values in the map are displayed

depending on the domain of the map. To retrieve information of a map layer,
make sure that the Info check box is selected in the Display Options dialog box
of that layer;

n A button in the button bar: performs the action of the button.

Continuously pressing the left mouse button
n On a map in a map window: continuous display of class names, IDs or values of

the data layers information in the window of which the Info box is marked.

Double-clicking
n A map in a map window: allows you to edit the attributes of this selection if an

attribute table is linked to the map, or allows you to edit the colors of this
selection. Choose the Double-Click Action command on the Layers menu to
select to edit attributes or colors.

Clicking the right mouse button
n On a map in a map window: a context-sensitive menu appears. You can choose

Select Area, Layer Management or Double-Click Action. Further, you can select
a layer of this map window to change its display options.

3.3 Table window

3.3.1 Introduction
A table window displays one table, a histogram or a two-dimensional table. A table
may be displayed as a regular table or record by record. A table consists of columns,
records and fields. You can edit the contents of the table, change the order of
columns, sort the table, perform calculations on the values in the table, copy the
contents of the table to the clipboard, create graphs from the table data, etc. You can
open as many table windows as you like.

A table window has a command line, located just below the menu bar, on which you
can enter your Table calculation formulae.

For information on minimizing or maximizing a table window, using scroll bars etc.,
see the Introduction on Windows features topic.
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3.3.2 Functionality
A table is displayed in a table window. Each table window displays one table. A
table consists of columns, records and fields. A table can be displayed in two ways:
as an overview of the whole table (Table View)and record by record (Record
View).You can open as many table windows on your screen as you like.

A table window has a command line on which you can enter your table calculation
statements. A status line is located at the bottom of a table window; it gives short
information on highlighted menu commands and it may give additional information
when the mouse pointer is located at a certain position in the table window.

When a table in Table View, record names appear on (gray) record buttons that are
arranged along the left side of the table. If the table is an attribute table, the record
buttons show the class names or IDs of the map to which this table relates. If the
table is not an attribute table, record numbers appear on the record buttons. Further,
column names appear on (gray) column buttons that are arranged along the top of
the table, just below the command line and the menu bar. The record and column
buttons in a table window are sensitive to clicking, double-clicking and drag-and-
drop actions.

Normally, a table window displays a table, a histogram, or a two-dimensional table.
Advanced users can also open objects that are internally stored as tables (point
maps; class, ID, and picture domains; class representations; georeference tiepoints)
as tables. You can then edit and calculate with the table-owned columns. For more
information, see How to open objects as a table. For more information on creating
new tables, see How to create a table.
To display existing tables in a table window, see How to display maps and tables.

To switch between Table View and Record View
When a table is opened, you see the table as a whole (Table View). If the table is too
large for the window, scroll bars appear. The table can also be shown record by
record (Record View).

To go to Record View:
n choose the Record View command on the Options menu,
n click the Switch View button (the upper left gray button in the table), or
n click a specific record button in the table.

In Record View, you can use the forward (> and >>) and backward (< and <<)
buttons to go to the next or previous records.

To return to Table View:
n choose Table View on the Options menu,
n click the Switch View button in the upper left button, or
n press Esc on the keyboard.
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To go to a specific record or column
In Table View, open the Options menu, choose Goto Record or Goto Column. Select
a record or a column and the table window will scroll to that record or column.
In Record View, open the Options menu, choose Goto Record. Select a record and
the table window will display that record.

To edit a table
A table can be edited in Table View and in Record View. For fields in columns that
use a value or identifier domain, you can select a field by clicking it with the mouse
pointer and directly start typing. For fields in columns that use a class domain, you
can select a field and then select a class name from the drop-down list. For more
information, see How to edit a table.

If you want to edit a lot of fields in the table, it is advised not to use the Enter key on
the keyboard, instead:
n to move downward or upward in the table to edit other fields, press the Down

Arrow or Up Arrow keys on the keyboard,
n to move to the right in a table to edit other fields, press the Tab key on the

keyboard,
n to move to the left in a table to edit other fields, press the Shift+Tab keys on the

keyboard.

Whenever you move to another field, the previously edited field is directly stored on
disk. You can stop editing by pressing Enter or Esc.

Only fields of source columns can be edited; you cannot edit fields of dependent
columns, fields of table-owned columns that store the results of a calculation or an
operation in a dependent table and fields of read-only columns. For more
information, see ILWIS objects : columns.

Calculations
You can calculate with columns by typing expressions on the TabCalc command
line. The command line is located just below the menu bar. For more information,
refer to Table Calculation. In TabCalc, some 50 internal functions are available, but
you can also define your own functions. Further, you can also use the command line
as a pocket line calculator, by starting an expression by a question mark. Through
the Columns menu, there are possibilities to perform aggregations and joins but
these can also be performed through the command line.

Column Management
On the Columns menu, use the command Column Management:
n to add and delete columns,
n to change the properties of a column: change the number of decimals shown for

a value column, change the width of a column, or change the expression of a
dependent column,

n to change the order of columns,
n to view whether dependent columns are up-to-date; if not, you can make

columns up-to-date.
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There are also some short cuts available using the keyboard and the mouse, see Help
topic How to use columns.

To add and delete records
If the table is an attribute table, records are part of a domain that is used by the table
and that is used by the map to which the table refers. To add a record to an attribute
table which uses a domain Class or ID, you have to add a class name or identifier to
that domain in the Domain Class/ID editor. To delete a record from a table which
uses a domain Class or ID, you have to delete an item from that domain in the
domain Class/ID editor (not advised).

To sort records
Open the Columns menu and choose Sort. You can sort on the domain and sort on a
column.

To copy (part of) the table into the clipboard
Open the Edit menu in the table window and select the Copy command. For more
information refer to Copy table selection to clipboard. Use the Paste option in
another Windows application to paste this selection into the other application.

To print a table
Open the File menu in the table window and select the Print command. You can
print the entire table or a selection of the table, and you can select the font for
printing.

See also: section 6 Table calculation and section 8.36.2 How to use columns

3.3.3 Table window Command line
The command line of a table window is located at the top of a table window, just
below the menu bar.

The command line of a table window is used to perform calculations with tables and
columns. Type your table calculation statements on the command line.
Further, the command line in a table window can be used as a pocket line calculator.

F The command line in each table window has a history: use the Arrow Up key to
retrieve previously used expressions.

The command line can be hidden or shown with the menu command Options,
Command line.

Pocket line calculator
The command line in the Main window and the command line of a table window
can be used as a pocket calculator.
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Type a question mark on the command line followed by an expression, i.e. a
combination of constant values and operators or functions. Map, table and column
names are not allowed in the pocket line calculator.

Examples

? 2 + 4 returns 6
? SQRT(64) returns 8
? POW(2,8) returns 256
? MyFunc(22,44,66) returns the result of a user-defined function 'myfunc'; the

first three parameters in this function are replaced by values
22, 44, and 66.

Constant value π can be used by typing PI, constant value e can be used by typing
EXP(1).

3.3.4 Table window Status line
A status line is located at the bottom of each table window.

The status line:
n gives a brief explanation on highlighted menu commands,
n gives a brief explanation when the mouse is located on a gray button:

- records: click to see and edit the record,
- column names: double-click to change column properties,
- upper left gray 'field': click to change to Record View, or to Table View.

n gives a brief explanation when the mouse is located on a field in the table field:
click to edit this field.

For more information, see Help topic How to use the status line.

3.3.5 Table window Menu commands
File Create Create Table ...

Create Function ...
Open Table ...
Print ...
Printer Set-up
Exit

Edit Copy
Paste
Delete
Select All
Properties ...
Edit Field

Column Add Column ...
Column Management
Sort ...
Update All Columns
Join ...
Aggregation ...



ILWIS window types

ILWIS Reference Guide 51

Cumulative ...
Least Squares ...

Options Record View
√ Table View
Show Graph ...
Rose Diagram ...
Confusion Matrix ...
Goto Record ...
Goto Column ...
√ Command Line
√ Status Line

Help See Main window

Menu commands - Graph window
File Print ...

Printer Set-up
Exit

Edit Copy Graph

Graph Add Graph ...
Graph Management
Grid Lines

Options Redraw Graph
√ Status Line
Legend

Help See Main window

3.3.6 Table window Mouse functions

Moving the mouse pointer over
n A column button: the status line gives a hint to double-click the column in order

to edit the column properties. The status line also shows the column name and its
description;

n A record button: the status line gives a hint to click the record name and go to
Record View;

n A field in the table: the status line gives information on the column name and the
description of the column;

n The Switch View button (upper left gray button): the status line gives a hint to
click the button to switch between Table View and Record View.

Clicking
n A field: allows you to edit the field. Editing fields is only possible when the

column is not a dependent column;
n A column button: selects the column. You may copy columns into the clipboard;
n A record button: when in Table View: shows the selected record in Record

View;
n The Switch View button: switches from Table View to Record View and vice

versa.
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Double-clicking
n A column name: the Column Properties dialog box appears. In case of dependent

columns created by an earlier TabCalc expression, you can set or change the
TabCalc expression to redefine and/or recalculate the column. You can also set
or change the column's domain, value range, precision, etc. in this dialog box.
Further, for any column type, you can change the position of the column in the
table, or set or change the width of the column. In case of a value column, you
can also set or change the number of decimals shown.

n To the right of the last column button: the Add Column dialog box appears.

Dragging
n A line separating column buttons: changes the width of the column (the

appearance of the mouse pointer changes to a double-sided arrow when you are
at the right position to start dragging);

n A column name to another position: moves the column to another position in the
table;

n The mouse pointer over a number of fields: select these fields. You may copy the
selection into the clipboard or print the selection;

n The mouse pointer over a number of records: selects these records. You may
copy the selection into the clipboard or print the selection.

3.4 Pixel information window

3.4.1 Introduction
Pixel info allows you to interactively inspect class names, IDs or values in one or
more raster, polygon, segment and point maps and attribute values in attribute
tables.

First, the pixel information window receives the XY-coordinate from the mouse
pointer (located in a map window) or the digitizer cursor (located on a referenced
paper map on the digitizer). Then, for this received coordinate, information of all
raster, polygon, segment and point maps that were added to the pixel info window is
retrieved and displayed simultaneously. For raster maps, the retrieved information
refers to the pixel pointed at with the mouse pointer, hence pixel info.

Open the pixel information window, add maps to the pixel info window (when an
attribute table is linked to a map or a domain these are also added), and move the
mouse pointer through a map window. The pixel info window displays:
n the XY-coordinate of the position of the mouse pointer in the map window;
n class names, IDs or values found in the maps at that position;
n attribute information found in attribute tables.
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Example

In this example the following information is retrieved for the current XY-coordinate:
n class name of polygon map Geology, and attribute information found in columns

gelatine, Lithology, and GeolAge,
n value of raster map Slopepct,
n class name of polygon map LandUse,
n class name of polygon map Geom, and attribute information found in columns

Description and Slides.

Whether pixel info displays class name, IDs or values of maps depends on the
domain(s) of the maps.

Attributes from an attribute table are retrieved when:
n the domain of a map is a class domain or an identifier domain, and
n the domain of the attribute table is the same as the domain of the map to which it

relates, and
n the attribute table is linked to the map or to the domain of the map.

The advantage of using pixel info, above using the left mouse button in a map
window (Info), is that you can get information on several maps at the same time and
also on attribute values.

For information on minimizing or maximizing the pixel information window, using
scroll bars, etc., see Introduction on Windows features.

3.4.2 Pixel info window Functionality
The pixel information window allows you to interactively inspect class names, IDs
or values in multiple raster, polygon, segment and point maps with the same or a
compatible coordinate system.
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When one map is displayed in a map window, the pixel information window is
capable of retrieving values of all maps added to the pixel info window, at the
position of the mouse pointer in the map window. In the same way, when you have
an analog paper map on the digitizer and you performed MapReference, the pixel
information window is capable of retrieving values of all maps added to the pixel
info window, at the position of the digitizer cursor.

To the pixel information window, you can add raster maps, polygon maps, segment
maps and point maps. When an attribute table is linked to one of those maps or to
the domains of the maps, the attribute information is also shown.

The pixel information window is used to gain an insight into your models.

Also, when only the object definition file of a dependent map exists, pixel info is
able to actually calculate output values of the maps on the fly. This is possible for all
output maps of MapCalc, and for output maps of the Classify, Densify, Filter,
Slicing and all Attribute Map operations.

Examples
n Create a number of dependent output maps with MapCalc, use slightly different

formulas, do not mark the Show check box in the dialog boxes; display an input
map in a map window; drag the dependent output maps to the pixel information
window, and check the results of the formula's used in the different maps.

n During Sampling, you can already create some dependent output maps with the
Classify operation (various methods, various parameters) using the current
sample set as input. When creating the dependent output maps, do not mark the
Show check box in dialog boxes; just create the definition for the output maps. In
this way the dependent output maps exist only by their object definition file and
are not yet calculated and stored on disk. If you then add these dependent maps
to the pixel info window, you can already see the results of classifying during
sampling.

Working with dependent maps which merely exist by their object definition file
saves calculation time and disk space. Only when the maps are displayed in a map
window, the calculation starts and the output pixel values are stored on disk.

General method to use Pixel Information
n display a map in a map window,
n open the pixel information window,
n add maps to the pixel info window (see below),
n move the mouse pointer through the map window, or move the digitizer cursor

over a referenced paper map on the digitizer.

The pixel info window will display:
n the received XY-coordinate of the position of the mouse pointer in the map

window, or of the digitizer cursor on the digitizer,
n the retrieved class names, IDs, or values of the maps added to the pixel info

window at that position,
n attribute information of these class names and IDs found in the attribute tables.
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The pixel info window either displays this information continuously for each
position of the mouse pointer in the map window, or only when you click with the
mouse pointer in the map window. This depends on the settings of the Continuous
check boxes in the Customize Pixel Info dialog box.

In case a map window only displays a raster map with georeference None, the pixel
info window displays the Row and Column numbers of the actual mouse position.

To open the pixel information window
From the File menu in the Main window or a map window, choose Open Pixel
Information. Or click the Pixel Information button in the button bar of the Main
window.

To add maps to the pixel information window
From the File menu of the pixel information window, choose the command Add
Map. Then select the raster, polygon, segment and/or point maps which you want to
add one by one. You can also drag maps from the Catalog into the pixel information
window. If an attribute table is linked to a map or to the domain of a map, the
attribute information is also shown. You can check whether an attribute table is
linked to a map or a domain in the Properties dialog box of the map or the domain.

To hide or show maps and attributes in the pixel info window
From the Options menu, choose Customize. You can also click on the upper left
gray area in the pixel info window. The Customize Pixel Info dialog box appears
which displays a list of maps, tables and columns. By clicking in this list, maps and
columns can be (de-)selected; selected items appear highlighted and will be shown
in the pixel info window.

Detailed pixel info by using the keyboard
To move the mouse pointer in the map window and see the result in the Pixel info
window, you can use the Arrow keys on the keyboard to move 1 screen pixel, or use
the Ctrl+Arrow keys on the keyboard to move 10 screen pixels.

Retrieved information
n for raster maps: the class name, identifier or value of the pixel;
n for polygon maps: the class name, identifier or value of the polygon;
n for segment maps: the class name, identifier or value of the nearest segment;
n for point maps: the class name, identifier or value of the point.

If no class name, identifier or value is found in a pixel or polygon, undefined (?) is
returned. Also, if in a point map you click outside a point, undefined is returned.

Further,
n for maps using a Picture or Color domain, the color is returned as (Red, Green,

Blue);
n for maps using a Bool domain, True or False is returned;
n for maps using a Bit domain, 0 or 1 is returned, etc.
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Closing the pixel information window
Close the pixel information window by double-clicking the Control-menu box in the
upper-left corner of the window. Or click the Control-menu box: the Control menu
is opened, choose Close. The size and position on the screen of the pixel information
window is automatically saved in the ILWISCFG.INI file.

Similar functionality
In the pixel information window you can get information on maps which are not
necessarily displayed, and you can get attribute information from a table that is
related to a map.
With map info you can only get information on different data or annotation layers
which are displayed in one map window. For map info, press the left mouse button
in a map window. Be sure that the Info check box on the layer's Display Options
dialog box is marked.

3.4.3 Pixel info window Status line
A status line is located at the bottom of the pixel information window.

The status line:
n displays brief information on highlighted menu commands,
n gives a brief explanation when the mouse is located on a gray area:

- upper left gray 'field': Customize the pixel information window,
- map and column names: map name and extension (.MPR, .MPA, .MPS, 
  .MPP) or column name and extension .CLM,
- retrieved information fields: the information as retrieved for this coordinate 
  from this map or column is repeated.

n gives a brief explanation when the mouse is located on a field in the table field:
click to edit this field.

3.4.4 Pixel info window Menu commands
File Add Map ...

Add Coordinate System ...
Print ...
Printer Set-up
Exit

Edit Copy

Options Customize
√ Always on top
√ Status Line

Help See Main window

3.4.5 Pixel info window mouse functions
The mouse pointer can be located either in a map window, then the pixel
information window shows current coordinate and retrieved information for the
maps (and tables) added to the pixel info window at this coordinate, or the mouse
pointer can be located in the pixel information window itself.
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Mouse pointer located in a map window

Moving the mouse over
n The map in the map window: if the pixel information is customized to

continuously receive coordinates from the mouse, the pixel information window
returns the XY-coordinate of the current position of the mouse pointer in the map
window. Subsequently, the pixel info window retrieves at that coordinate the
class names, identifiers and/or values of the maps (and tables) added to the pixel
info window.

Clicking
n The map in the map window: if you cleared the continuous check box for the

mouse pointer in the Customize Pixel Info dialog box, the pixel information
window returns at a click in the map window the XY-coordinate of the current
position of the mouse pointer in the map window. Subsequently, the pixel info
window retrieves at that coordinate the class names, identifiers and/or values of
the maps (and tables) added to the pixel info window.

Mouse pointer located in the pixel information window

Moving the mouse over
n Map and column names: the status line shows the map name and its extension

(.MPR, MPA, MPS, MPP) or the column name and the extension .CLM;
n Coordinates and retrieved information from maps and tables: the status line

repeats the information.

Clicking
n The upper left gray field: the Customize Pixel Info dialog box appears;
n The gray button above the coordinates and retrieved values: selects the current

coordinate and retrieved information for this coordinate. You may copy this to
the clipboard;

n A gray map name or column name: selects the map (or column) name and the
retrieved value for this position. You can copy this to the clipboard. Hold the
Shift key down to select multiple map and column names and their retrieved
values;

n A retrieved value: selects this value. You can copy this to the clipboard. Hold the
Shift key down to select multiple retrieved values.

Dragging
The line between the upper left gray field and the gray button above the coordinates
and retrieved values: changes the width of the column containing the map and
column names. The appearance of the mouse pointer changes to a double-sided
arrow when you are at the right position to start dragging.




